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Create a Photo Album 
Microsoft PowerPoint creates a new presentation when you use the photo album feature. Any presentations you currently have open in 
PowerPoint will not be affected by this task.  

1. Go to Insert  Picture  New Photo Album.  
2. In the Photo Album dialog box, add the pictures you want to appear in your photo album.  
3. Under Album Layout, do any of the following:  

• If you want to select the layout of your pictures and text boxes on the slides in your photo album, select a layout in 
the Picture layout list. If you select Fit to slide as your picture layout, you are unable to add or change frame shapes 
and design templates.  

  Always use the Format 
Photo Album dialog box when 
making changes or updates to 
your photo album. 

• If you want to select the shape of a frame to use with your pictures, select a 
shape in the Frame shape list.  

• If you want to select a design template to use for your photo album, click 
Browse, and then in the Choose Design Template dialog box, locate the 
design template you want to use, and then click Select.  

4. Click Create.  

Add captions to a photo album   
1. Open the photo album you want to make changes to.  
2. Go to Format  Photo Album, and then under Picture Options, select Captions below ALL pictures.  

  If your picture layout is Fit to slide, you cannot add captions below your pictures. 
3. Click Update.  
4. In normal view, add the text you want in each text box under each picture— if you don't add your own text for each caption, 

Microsoft PowerPoint will automatically use the file name of each picture as the caption.  

Move pictures and text boxes in a photo album  
1. Open the photo album you want to make changes to.  
2. Go to Format  Photo Album.  
3. In the Format Photo Album dialog box, under Pictures in album, select a picture or text box, and then  

click Move Up  or Move Down .  
4. Click Update. 

Set layout and design options in a photo album  
1. Open the photo album you want to make changes to.  
2. Go to Format  Photo Album.  
3. In the Format Photo Album dialog box, under Album Layout, do any of the following:  

• If you want to select the layout of your pictures and text boxes on the slides in your photo album, select a layout in 
the Picture layout list. If you select Fit to slide as your picture layout, you are unable to add or change frame shapes 
and design templates.  

• If you want to select the shape of a frame to use with your pictures, select a shape in the Frame shape list.  
• If you want to select a design template to use for your photo album, click Browse, and then in the Choose Design 

Template dialog box, locate the design template you want to use, and then click Select.  
4. Click Update.  

http://www.what-is-net.info/computers.html
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Create a Custom Design Template 

Create a Custom Color Scheme 
A color scheme consists of the eight colors used in the design of the slide. A presentation’s color 
scheme is determined by the design template that’s applied. View a slide’s color scheme by 
selecting the slide and then displaying the Slide Design-Color Schemes task pane.  

 

Colors in the color scheme 

New colors added to the presentation. You can add and 
display up to eight new colors. Colors you add that aren't in 
the color scheme will not change or update if you reapply the 
scheme or make changes to the design template.

Change the Background 
1. Go to Format  Background 
2. Click the Background fill drop-down list and select a color or choose Fill Effects 
3. Click the appropriate button to apply to the current slide or all slides of the presentation. 
• To hide graphics for an active or selected slide, on the Format menu click Background. Then, in the Background dialog box, 

select Omit background graphics from master.  
• You can add a Title Master to use different formatting and graphics on title slides from other slides in your presentation. To 

do this, switch to Slide Master View. Then, select New Title Master from the Insert menu. 

Modify the Slide Master  
Go to View  Master  Slide Master. 

Format Text 
1. Click a text placeholder to edit/add text OR press 

CTRL+ENTER to activate the next placeholder on a 
slide, then go to Format  Font OR right-click the 
selected text and choose Font OR use the Formatting 
toolbar.  

Format Line Spacing 
1. Go to Format  Line Spacing… 
2. Make appropriate changes, and then click OK . 

Format Bullets 
1. Go to Format  Bullets and Numbering… 
2. Select the bullet style you want. 
3. Click OK . 

Save a Custom Design Template 
1. Go to File  Save as… 
2. Give your template a name and  

Save as type: Design Template (*.pot). 
3. Click Save . 
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Advance Formatting Options 

Copy and paste formatting 
1. Select the text that contains the formatting you’d like to copy. 

2. Click Format Painter  (CTRL+SHIFT+C) on the Standard toolbar to turn it on.  
Double-click the button is you’d like it to remain on for multiple applications. 

3. Select the text you’d like to have the formatting applied to (CTRL+SHIFT+V). 

Placeholder formatting options 
Select the placeholder, then go to Format  Placeholder OR double-click the placeholder 

 

Replace a font 
Go to Format  Replace Fonts… 

 

Embed fonts 
1. Go to File  Save As.  
2. On the toolbar, click Tools, click Save Options, select 

Embed TrueType Fonts, and then do one of the 
following:  
• To embed only those characters used in the 

presentation, select Embed characters in use only 
(best for reducing file size).  

• To embed all the characters in the font set, select 
Embed all characters (best for editing by others). 

Find and Replace 
Find 
Go to the Edit menu and select Find OR press CTRL+F.  

  

2.  Click to find all occurrences of the 
word or phrase. If the first occurrence 
is not the one you’re looking for, click 
again to go to the next occurrence. 

1.  Type the word or phrase 
you’re looking for here. 
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Replace 
Go to the Edit menu and select Replace OR press CTRL+H.  

  

Use Media Effectively in your Presentation 
It's easy to lose your presentation's focus if your slides are filled with too many graphic elements, animations, and special effects. Your 
slides should follow a simple design that keeps you and your audience from being distracted by too much happening on the screen. 

You use PowerPoint well when people don't notice that you use PowerPoint at all. Call attention to your ideas, not to the medium 
itself. The most important outcome of the presentation is that the audience understands the meaning you intend to communicate. 
When you finish the presentation, you want the audience to talk about your special ideas, not your special effects. 

Use sound recordings when sending a presentation electronically 
A clean slide that emphasizes key points is more effective than a slide that contains every word you intend to say. But, what do you do 
if you’re sending your presentation electronically? Consider recording narration to accompany your slides.  
• To record sound for a single slide, go to Insert  Movies and Sounds  Record Sounds. 

Record a voice narration or sound in a slide show 
1. Go to Slide Show  Record Narration. A dialog box appears showing the amount of free disk space and the number of 

minutes you can record. 
2. To insert the narration on your slides as an embedded object and to begin recording, 

click OK. To insert the narration as a linked object, select Link narrations in, and 
then click OK to begin recording. 

3. Advance through the slide show and add narration as you go. 
4. At the end of the show, a message appears.  To save the timings along with the 

narration, click Yes. To save only the narration, click No.  

A sound icon appears in the lower-right corner of each slide that has narration. 

Insert music or sound on a slide 
1. In normal view, display the slide you want to add music or sound to. 
2. Go to Insert  Movies and Sounds. 
3. To insert a sound from the Clip Organizer, click Sound from Clip Organizer, and then double-click the sound you want as it 

appears in the task pane on the left of the screen. 
To insert a sound from another location, click Sound from File, locate the folder that contains the sound, and then double-
click the sound you want. A sound icon appears on the slide. 

  

4.  Click to replace the currently selected 
occurrence or to replace all occurrences at once.

1.  Type the word or phrase 
you’re looking for here. 

2.  Type the word or phrase to replace 
the found word or phrase with. 

3.  Click to find all occurrences of the word or phrase. 
If the first occurrence is not the one you’re looking for, 
click again to go to the next occurrence.

 Because voice narration takes 
precedence over all other sounds, 
if you’re running a slide show 
that includes both narration and 
other sounds, only the narration 
will be played. 
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By default, the sound will start when you click the sound icon during a slide show. To change how you start a sound: 
1. Go to Slide Show  Custom Animation. 
2. Click on the object in the list as it appears in the task pane.  
3. Click on the down arrow beside the object and select Effect Options… 
4. Click on the Timing tab. 
5. Select from the list. 

How to keep playing a sound through several slides 
Normally, a sound added to one slide plays only while that slide is showing and stops 
when you go to the next slide.  To keep a sound (music or other sound) playing 
through several successive slides:  

1. Add the sound as usual to the slide where the sound will start playing. 
2. Click once on the sound icon to select it. 
3. Go to Slide Show  Custom Animation. 
4. Click on the object in the list as it appears in the task pane.  
5. Click on the down arrow beside the object and select Effect Options…  
6. Click on the Effect tab. 
7. Adjust the Stop playing action. 

Insert a CD audio track on a slide 
1. In slide view, display the slide you want to add a CD audio track to. 
2. Go to Insert  Movies and Sounds  Play CD Audio Track 
3. Select the track and timing options you want, and then click OK. A CD icon 

will appear on the slide. 
  

  You DO need to insert the CD in the drive to have the music play while presenting.  If you don’t want to need the CD while 
presenting, copy the sound file to your computer first using the Windows Media Player.  Put a copy of the audio file in a folder along 
with your PowerPoint Presentation, where it should be inserted into the PowerPoint from. 

Your sound must be saved as a 
.wav file. It will play until you 
have another sound, so do not 
include any more sounds from 
this point forward. It will 
continue to play until the end of 
the presentation.

Play music throughout a Presentation 
1. Open the Slide Transition task pane. 

 

3.  Select to loop.

2.  Select your sound (wav). 

Drawing Object and Clip Art Tools 

Using the Grid and Guides  
Go to View  Grid and Guides….  
The grid will overlay a grid over the top of your slide.  
The guides will split the slide vertically and horizontally. 

If you like using guides, but wish there were more, you can create additional Guides by simply 
holding down CTRL while dragging on an existing Guide. This will create a new guide. To get 
rid of guides, just drag them off the edge of the slide. 
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Use the Drawing Tools 
Open the Drawing toolbar by right-clicking any toolbar and select Drawing  
OR go to View  Toolbars  Drawing. 
To do this Do this 

More modifications options Right-click  Format AutoShape… to open the Format AutoShape dialog box 

Constrain an object to perfect proportions Hold SHIFT while drawing or resizing 

Draw or resize the object from the center Hold CTRL while dragging 

Duplicate a selected object Press CTRL+D OR go to Edit  Duplicate 

Add text to a shape Right-click  Add Text 

Align objects Draw   Align or Distribute 

Change orientation (rotate or flip) Draw   Rotate or Flip  
OR click Free Rotate (green dot) handle on the object and drag to rotate 

Change the shape Draw   Change AutoShape 

Change the layering order Draw   Order 

Group and Ungroup Objects  
1. Select the objects to group. (Use SHIFT-click or draw a pointer marquee) 
2. On the Drawing toolbar, go to Draw  Group. 

 
1. Click WordArt  on the Drawing toolbar. 
2. Select the style and click OK  
3. Type the text. 
4. Choose the font and style  
5. Click OK   

Use the WordArt and Drawing toolbars to modify and format the text.  
(If you don’t see the toolbar, click on the WordArt text to make it active.) 

 

 
 
 

Use Visual Mnemonics 

Having problems trying to remember what you want to say? Try using graphic elements to trigger 
your memory about key points. For example, if you plan to make six key points in the 
presentation, use a photo that can be associated with each point, such as a ship's steering wheel. 
Each handle of the wheel can act as a reminder of each of your points. 

When you use an image on a slide as a visual mnemonic, you can make your ideas, as well as the 
presentation, memorable. 

Modify Clipart  
Recolor Clipart 

1. Select the picture you want to modify.  

2. On the Picture toolbar, click Recolor Picture .  
3. To choose a different color, click the arrow next to the new color to see more colors.  

 

Insert 
WordArt 

Edit Text 

WordArt Gallery applies  
pre-designed formats More formatting 

options 

Text Wrap

Toggle text between  
horizontal and vertical 

Alignment 

Character Spacing 

Format shape Makes lowercase letters the 
same height at uppercase 
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Convert Clipart into a drawing object 

1. Right-click the Clip Organizer picture you want to modify and click Edit Picture.  
2. Click Yes  when the message box appears.  
3. Use the tools on the Drawing toolbar to modify the objects.  

Presentation Navigation 

Add Hyperlinks 
1. Select the object to be the hyperlink. 
2. Go to Insert  Hyperlink 
3. Under Link to section, select the type of hyperlink. 
4. Click OK  when finished. 

 

Use Action Buttons 
1. Select the slide you want to place a button on. 
2. On the Slide Show menu, point to Action Buttons, and 

then select the button. 
3. Click the slide. 
4. In the Action Settings dialog box, set the actions that 

you want on the Mouse Click and Mouse Over tabs, 
and then click OK.  

Hidden Slides 
Slides can be hidden; this is useful if, for example, you want to give a slightly different talk to different audiences. To view a hidden 
slide, press H at the appropriate time in the slide presentation. 

1. Select the slide to hide in Slide Sorter view.  
2. Click Hide Slide. Notice that the slide number (below the slide) is crossed-out when a slide is hidden.  
3. Click on Hide Slide again to restore the slide to the show.  

Custom Shows 
Custom shows let you create a presentation within a presentation. Instead of creating multiple, nearly identical presentations for 
different audiences, you can group together and name the slides that differ and then jump to these slides during your presentation. 

1. Go to Slide Show Custom Shows New.  
2. Under Slides in presentation, select the slides you want to include in the custom show, and then click Add . To select multiple 

slides, hold CTRL as you click the slides.  
3. To change the order of slides, select a slide, and then click one of the arrows to move the slide up or down in the list. 
4. Type a name in the Slide show name field, and then click OK .  

5. To see a preview of a custom show, select the name of the show in the Cus om Shows dialog box, and then click Show .  t

3.  Select the check box for each 
color you want to change. 

4.  To choose a different color, click 
the arrow to see more colors.
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Review Presentations 

Send a Presentation for Review 
1. Go to File  Save As… 
2. Name the presentation and  

Save As Type: Presentation for Review. 
3. Send the presentation via network, e-mail or disk. 

Review a Presentation 
1. Open the presentation to review. 
2. Make any necessary changes and save. 

Apply Reviewer Changes 
1. Open both presentations to combine. 
2. Click Yes  to confirm that you want to merge the 

presentation. 
Click a change marker, and then select the check boxe3. s of 

sentation. the changes you want to apply to your pre
4. Repeat step 3 until all changes are made. 
5. On the Reviewing toolbar, click End Review . 

6. Click Yes  to confirm that you want to end the review. 

Comp
1. 
2. ons.  
3. e

to M

• To display the results in the currently open 
presentation, click Merge into current 
presentation.  

• To display the results in a new presentation, click 
Merge into new presentation.  

 

are and Merge Presentations 
Open the edited copy of the presentation.  
Go to Tools  Compare and Merge Presentati
Sel ct the original presentation, click the arrow next 

erge, and then do one of the following:  
• To display the results of the comparison in the 

original presentation, click Merge. 

Deliver a Presentation 

Set up an Automatic Show 
1. On Slide 1, select Slide Show  Rehearse Timings 
2. Read at a comfortable pace and click Next  
3. Continue for all slides until end of show. 
4. Click Yes  to save timings. 
5. To use the timings, go to Slide Show  Set Up Show 
6. Be sure Browsed At A Kiosk (Full Screen) is selected. 
7. Click OK . 

Start a Slide Show Automatically 
1. Go to File Save As…  
2. Under Save As Type, select .  PowerPoint Show (*.pps)
3. Name your file and click OK . The next time you open 

this file from outside of PowerPoint, your slide show 
will begin automatically. 

Add Emphasis during a Presentation 
POINTER:  In Slide Show view, right-click  Pointer 
Options  Arrow (CTRL+A) 
PEN:  In Slide Show view, right-click  Pointer Options  

 Meeting Minder  

2. , type your notes. 

nd due date.  

Pen (CTRL+P) 

Take Meeting Notes 
1. In Slide Show view, right-click 

Meeting Minutes tab 
In the Description box 

3. If necessary, click the Action Item tab. 
a. Provide a description, assignment a
b. Click Add  to add more items. 

c. Click OK  when finished. 

4. d click OK .  Repeat for every action item an
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Take a Presentation on the Road 
This feature will set up your presentation (including linked files) on a CD or folder so that the slide show will run correctly for any 
recipient. It even adds a PowerPoint viewer so that the recipient’s computer doesn’t need PowerPoint to run the show. 

1. Open the presentation that you want to package.  
2. On the File menu, click Package for CD.  

 
 

3.  Type a name for the CD or folder. 

4.  Click to specify the presentations that you 
want to include, as well as the play order. 

5.  Select any of the following: 
 To exclude the PowerPoint Viewer, clear 

the PowerPoint Viewer check box.  
 To prevent presentations from playing 

automatically, or to specify a different 
automatic play option, click an option in 
the Select how presentations will play 
in the viewer list.  

 To include TrueType fonts, select the 
Embedded TrueType fonts check box.  

6.  Click when finished. 
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